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1.1.

1.2.

1.3.

Introduction

This manual

This manual provides thorough information on the SPA-ZC 400 Ethernet Adapter
and the central concepts related to it. SPA-ZC 400 Ethernet Adapter is used for
connecting REF 541/3/5, REM 543/5 and RET 541/3/5 Intelligent Electronic
Devices (IED) to the SPA/TCP Bridge. In the manual you find information on
SPA-ZC 400 and its components, an introduction to engineering tasks and a
description of the basic operations.

The information in this manual is intended for application engineers, who install and
configure SPA-ZC 400.

Use of symbols

This publication includes the following icons that point out safety-related conditions
or other important information:

The electrical warning icon indicates the presence of a hazard which
could result in electrical shock.

>

ih"““ The caution icon indicates important information or warning related to
- the concept discussed in the text. It might indicate the presence of a
hazard which could result in corruption of software or damage to
equipment or property.

E The information icon alerts the reader to relevant facts and conditions.

It should be understood that operation of damaged equipment could, under certain
operational conditions, result in degraded process performance leading to
information or property loss. Therefore, comply fully with all notices.

Intended audience

This manual is intended for installation personnel, administrators and skilled
operators to support installation of the software.
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1.4. Product documentation
Name of the manual Document ID
SPA-ZC 400 configuration CD 1MRS151048
CAP 505 User's Guide 1MRS752292-MUM
SPA-ZF Optical glass fibres, multimode granded [1MRS755371
index type
Plastic-core fibre-optic cables, Features and 1MRS752089
instructions for mounting

1.5. Document conventions

The following conventions are used for the presentation of material:
e The words in names of screen elements (for example, the title in the title bar of a
dialog, the label for a field of a dialog box) are initially capitalized.

e Capital letters are used for the name of a keyboard key if it is labeled on the
keyboard. For example, press the CTRL key. Although the Enter and Shift keys
are not labeled they are written in capital letters, e.g. press ENTER.

e Lowercase letters are used for the name of a keyboard key that is not labeled on
the keyboard. For example, the space bar, comma key and so on.

e Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

e Press ALT E C indicates that you press and release each key in sequence (to copy
a selected object in this case).

e The names of push and toggle buttons are boldfaced. For example, click OK.
e The names of menus and menu items are boldfaced. For example, the File menu.

e The following convention is used for menu operations: Menu Name > Menu
Item > Cascaded Menu Item. For example: select File > Open > New Project.

e The Start menu name always refers to the Start menu on the Windows Task Bar.

e System prompts/messages and user responses/input are shown in the Courier
font. For example, if you enter a value out of range, the following message is
displayed: Entered value is not valid.

You may be told to enter the string MIF349 in a field. The string is shown as
follows in the procedure: MIF349

e Variables are shown using lowercase letters: sequence name
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1.6.

Revision history

Version Date History

A 30.06.2006 Document created

B 20.05.2009 SPA-ZC 400 2.1.2 additions
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2. Safety information

Non-observance can result in death, personal injury or substantial
property damage.

Only a competent electrician is allowed to carry out the electrical
installation.

National and local electrical safety regulations must always be

followed.
i\ The device contains components which are sensitive to electrostatic
l\ s/ discharge. Unnecessary touching of electronic components must

therefore be avoided.

11
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SPA-ZC 400

Product overview

SPA-ZC 400 is used to connect one REF 541/3/5, REM 543/5 or RET 541/3/5
device with the SPA protocol over the TCP/IP network using the same Ethernet link.
SPA-ZC 400 provides simultaneous dual port communication for fibre-optic SPA

and LON.
| B Substation
[ Monitoring To control
And Controlling centers
: System
T SPA/Ethernet - : COM600
adapters i
SPAEZC ¥ Industrial gg?es&?;'on
400and 402 u®  GPS fibre-optic y
- S~ Ethernet switch TCP/IP
.~ network
éB \(E pesassnn
- - - T
: = Te— = = -
. cous 58 - - e | e e .
- - 3rd party devices
REF 543 REF 610 REX 521

A090000

Fig. 3.-1 Conceptual picture of a typical system setup

The mechanical and electrical connection of the Ethernet adapter to a REF 541/3/5,
REM 543/5 or RET 541/3/5 interface is described in Section 4. Installation. The
Ethernet adapter programming is described in Section 5. Engineering.

It is a prerequisite to understand the communication properties of Intelligent
Electronic Devices (IED) before connecting to the Ethernet adapter. This
information is available in the manual for the protection relay in question. It is also
necessary to have basic understanding of the SPA/TCP Bridge to which the IEDs
will be connected.

ABB has tested the following third-party devices, which are recommended to be
used with SPA-ZC 400:

Industrial 10/100 MBit switches:

e RuggedCom RS800
e RuggedCom RS1600
e Westermo FST208

Media converters:

¢ RuggedCom RMC-100-MM
e IMC McBasic MM1300
e Allied Telesyn AT-MC302-20

More tested devices can be found on the ABB web site
http://www.abb.com/substationautomation.

13
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3.1.

3.2.
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SPA-ZC 400 and optional LON/SPA interface

The optional LON/SPA interface provides a connection between the REF 541/3/5,
REM 543/5 or RET 541/3/5 device and the fibre-optic SPA and LON. The bus
connection module converts incoming optical signals from the SPA and LON bus to
electrical RS-485 signals for the REF 541/3/5, REM 543/5 and RET 541/3/5 devices
and vice versa. It contains a service pin for LON nodes.

The optional interface can be used in loop- and star-type bus topologies. It is
possible to select the idle state of module line. The light can be turn on or off. The
jumpers select the bus topology (loop or star) depending on whether the light is
turned on or off.

In the loop topology, the interface receives the message from the fibre-optic
interface and passes it both to the fibre-optic transmitter and to the RS-485 interface.
In the star topology, the interface receives the message from the fibre-optic receiver
and passes it only to the RS-485 interface. If the message is received from the RS-
485 interface, it is passed to the fibre-optic transmitter in both bus topologies.

The SPA bus communication uses loop and light off modes, when the module
jumpers are in loop- and light off- positions. The LON bus communication uses star
and light off modes, when the module jumpers are in star- and light off-positions.

In the LON bus communication the optional interface supports collision detection.

The service pin is connected via the RS-485 interface to the device's Neuron chip,
which is connected to the interface.

Table 3.1.-1 Settings of the jumper

Topology Light on/off Protocol
Star Light off LON/SPA
Star Light on Not supported
Loop Light off LON/SPA
Loop Light on Not supported

Features

SPA-ZC 400 has the following features:

¢ Simultaneous dual port communication (plastic and fiber optic connections) for
IEC 61850 and LON/SPA

e Support of communication over TCP/IP

E Only one SPA client can be configured to poll SPA events from the
device.
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3.3.
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Fig. 3.2.-1 Parts of SPA-ZC 400

Ethernet connector

LON/ SPA bus connector (optional)
LON/ SPA Rx LED

LON service pin

LAN and diagnostics LEDs

DN W=

Transmission Control Protocol (TCP)

The Transmission Control Protocol (TCP) is the most commonly used protocol for
exchanging data between communication devices using Ethernet. Unlike UDP, the
TCP protocol guarantees reliable transmission between applications. TCP also
distinguishes data for multiple, concurrent applications running on the same host.

A data message sent as a TCP/IP message means that the higher layer Transmission
Control Protocol assembles the message or file into smaller packets. These are then
transmitted over the Internet and received by a TCP layer which reassembles the
packets into the original message.

15
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41.

4.2.

4.21.

422,

Installation

This chapter describes the installation of the SPA-ZC 400 module and the
Communication Engineering Tool (CET) for SPA-ZC 40x. For additional
information, such as technical data, maintenance and service, refer to Section 7.
Technical data and Section 8. Maintenance and service.

Mechanical installation

Connect the SPA-ZC 400 module to REF 541/3/5, REM 543/5 or RET 541/3/5 and
screw SPA-ZC 400 to the 9-pin type D-connectors. Connect the LAN cable to the
LAN connector of SPA-ZC 400. The other end of the cable is connected to the SPA
protocol over TCP/IP through the Ethernet switch.

Communication Engineering Tool for SPA-ZC 40x

System requirements

Communication Engineering Tool (CET) for SPA-ZC 40x runs on Windows 2000,
Windows XP and Windows Server 2003 operating systems. A PC capable of
running one of these operating systems is sufficient also for CET for SPA-ZC 40x.
For more information, refer to Section 1.4. Product documentation. The detailed
system requirements can be seen below.

e 20 MB free hard disk space if Microsoft .NET Framework 1.1, which is required
for running CET for SPA-ZC 40x, has already been installed.

e 100 MB free hard disk space, if the Microsoft .NET Framework 1.1 is not
installed. It is installed automatically if it is not found.

Installing Communication Engineering Tool for SPA-ZC 40x

1. Uninstall the previous version.

2. Close all the open programs and insert the Communication Engineering Tool
(CET) for SPA-ZC 40x installation CD to the CD-ROM drive of your PC.

3. The Installation program starts automatically. If this is not the case, open the
program by starting setup.exe on the CD drive.

4. The installation wizard extracts the installation files to your local computer.
5. The CET for SPA-ZC 40x Installation program starts. In this dialog, click Next.

e With the Back button you can return to the previous dialog, and with the
Cancel button, exit the installation wizard. This applies to all the dialogs in
the installation wizard.

6. Read the License Agreement, select the option I accept the license agreement
and click Next to continue the installation.

e If the option I do not accept the license agreement is selected, the Next
button is not available and you cannot continue the installation.

7. Select the folder in which the application is to be installed.

17
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e To select the default folder shown at the bottom of the dialog, click Next.
e To select another folder, click Browse, choose the folder you want and click
Next.
8. Both manuals are installed by default on your local hard drive. Click Next to
continue the installation.
e To install a manual, click the respective manual and select Will be installed
on local hard drive.
e To install the documentation feature, click the respective manual and select
Entire feature will be installed on local hard drive.
e To install the manual when required, click the respective manual and select
Feature will be installed when required.
e Not to install the manual, click the respective manual and select Entire
feature will be unavailable.
9. Click Next to begin the installation.
10.Follow the progress of the installation in a dialog that also shows the directory

path where the files are copied. At this point, you can still cancel the installation
by clicking Cancel.

11.A dialog opens to show that the tool has been successfully installed. Close the
dialog and finish the installation by clicking Finish.

12.When clicking Finish, the wizard also installs the Microsoft SQL Server
automatically, if it is not installed already.

13.Start CET for SPA-ZC 40x by selecting Start > Programs > Communication
Engineering Tool for SPA-ZC 40x > Communication Engineering Tool.

Uninstalling Communication Engineering Tool for SPA-ZC 40x

1. Open the Add or Remove Programs dialog by selecting Start > Settings >
Control Panel > Add or Remove Programs.

2. Select Communication Engineering Tool (CET) for SPA-ZC 40x and click
Remove.

Uninstall CET for SPA-ZC 40x in order to install a new version and to
update the software. Uninstallation does not remove the Microsoft
SQL Server and .NET Framework. Removing these programs can
affect the functionality of the other ABB applications.

Detailed instructions for upgrading the software are provided when the
upgrade is available.

Connecting to SPA-ZC 400

The Sections 4.3.1. and 4.3.2. describe how to connect to SPA-ZC 400 from the
Communication Engineering Tool (CET) for SPA-ZC 40x.
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4.3.1.

43.2.

Changing computer's IP address

To connect SPA-ZC 400, the used computer and SPA-ZC 400 must use the same
address space.

To change the computer's IP address space to be the same as in SPA-ZC 400:

1. Open the Network Connections in Control Panel.

2. Type, for example, the following IP address to the IP address box: 192.168.2.1.
See Fig. 4.3.1.-1.

You must have system administration rights to perform the task.

Internet Protocol (TCP/IP) Properties 7| x|

General

Y'ou can get [P zettings azsigned automatically if vour network, support:
thiz capability. Othenwise, you need to ask your network, adminiztratar for
the appropriate |P settings.

™ Obtain an IP address automatically

—{* ze the following IP address;

IF address: 192168, 2 . 1
Subnet mazk: I 285 266 285, 0
Default gateway: I

= Obtain DHE semen address automatically

—i% Uze the following DMS server addresses:

Preferred DS server: I

Alternate DS server: I

Advanced... |
k. I Cancel |

A060241

Fig. 4.3.1.-1 Changing IP address

Checking connection to SPA-ZC 400

Check the connection to SPA-ZC 400 by using the ping command:

1. Open the Run dialog.
2. Type cmd to the Open box, see Fig. 4.3.2.-1.

19
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Run 2| x|

Type the name of a program, folder, document, ar
Inkernek resource, and Windows will open it For wou,

Open: =]

(0] 4 I Cancel | Browse, .. |

A060242

Fig. 4.3.2.-1 Starting command prompt

3. Click OK to run the command prompt.
4. Type ping 192.168.2.10, see Fig. 4.3.2.-2.

C:\Dping 192.168.2.18

Pinging 192.168.2.18 with 32 bytes of data:

Reply from 192.168.2.18: bytes=32 timed{ims TTL=255%
: hytes=32 time{ims TTL=255

: bytes=32 time{ims TTL=255
: bhytes time<ims TTL=255

Pingpstatistics for 192.168.

ackets: Sent = 4, Recei - Lost = @ {8z loss>.
in milli—seconds:
Mininum = Bms, Maximum = Bms. Average = Bms
IC D,

Fig. 4.3.2.-2  Pinging SPA-ZC 400

SPA-ZC 400responds to the ping command if the computer and SPA-ZC 400 are
on the same network.

5. If SPA-ZC 400 responds with the IP address, the connection is established
between the computer and SPA-ZC 400.
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5.1.

5.2.

Engineering

This section guides when performing the engineering tasks required before using
SPA-ZC 400.

manual. You must have engineering rights to be able to perform the

E Note that all the possible engineering scenarios are not included in this
tasks described in this section.

Overview of engineering

The engineering and maintenance of SPA-ZC 400 is done by using CET for
SPA-ZC 40x functions. The device's communication structure is described in the
Project Explorer dialog. The structure is built by using device objects. These objects
have communication properties that can be accessed through the Object Properties
dialog. These properties define for example the IP addresses, unit addresses, and
descriptions.

The communication structure consists of SPA devices.
When the structure is complete and all the objects have been set up properly, the
configuration is downloaded through FTP to SPA-ZC 400 by using the CID

(Configured IED Description) Export function.

The engineering tasks are the following:

—

. Building an object tree by adding a device to the configuration

2. Configuring object properties, for example modifying TCP/IP address
3. Configuring SPA communication parameters

4. Exporting configuration data to SPA-ZC 400

Application notes

Since the SPA protocol is designed to be used in a defined environment on serial
lines with one master only, it has some deficiencies when using it on top of other
protocols, for example on TCP/IP.

The SPA protocol does not have a mechanism for linking poll and response
messages together, only mechanism to order the messages . If the order is disturbed,
for example, by unpredictable delays or message duplication in the network, the
data consistency cannot be guaranteed. For the same reason, only one master can be
reliably used with an SPA bus, as it is not possible to identify from the responses to
which master poll the response is intended.

The following communication paths are considered safe for SPA communication:

21
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Direct connection via serial cable or fibre (conventional usage of SPA bus)

Conventional modem connection, when used as a direct connection, running on
the SPA protocol only

GSM modem connection, when used as a direct connection, running on the SPA
protocol only

Serial connection over TCP/IP in a dedicated LAN with deterministic behavior,
if one active master program or process is guaranteed

The following communication paths are considered unsafe:

Serial connection over TCP/IP in a network with indeterminate delays, for
example, the Internet and packet networks (for example GPRS)

Serial connection over UDP/IP without additional protocol to provide reliable
delivery

Any setup with several programs, devices or processes accessing the same SPA
device at the same time through a shared link

Creating project

You need to start the Communication Engineering Tool (CET) for SPA-ZC 40x to
open and name a project, see Fig. 5.3.-1 and Fig. 5.3.-2.

EETLocal Server',REF543R IEC61850 Test - Commu

File | Edit  Miew  Tools  Window  Help

||E’; OpeniManage Projeck. .. Chrl+0 |
Close Project

Save k45
Reload Current Project Ckrl+35hift+F11

Exit

Fig. 5.3.-1

A040013B

Opening a project



1MRS756018

Ethernet Adapter SPA-ZC 400
SPA/TCP Bridge

Installation and Commissioning Manual

5.4.

x
Currently available projects:
E Frojects on my computer
% &l New Project x|
New Project Server name:
|VINFL‘I 024PCMSERYER
B Project name:
Sl P |Protocol Tes|
% D ezcription;
Import Project
R
Export Project
IE [Ipen Project |
% Create I Cancel |
Pro Cloze |
SOL Server
Service
M anager

A040014B

Fig. 5.3.-2 Creating a new project

Restarting

Use this function to restart the SPA-ZC 400 at runtime.

1. Select IED and Tools > Reset Tool to open the restart panel, see Fig. 5.4.-1
2. Click Reset.

The results are reported to the UI text box.

[f’ T"\ Do not use the restart function while downloading configuration to
e J SPA-ZC 400. When download is finished, SPA-ZC 400 is restarted
- automatically.

File  Edit  Wiew
==

Project Explorer

Window  Help
Signal Mapping
IP Query Tool

Communication | ID Expart
E @ Exam |l Restart SPAZC40x
: SCD Browser

ple

Opkions. ..

A060396

Fig. 54.-1 Restarting

23
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5.5. Building object tree

After creating the project you need to build and configure an object tree in the
Communication Engineering Tool (CET) for SPA-ZC 40x to define the
communication structure.

Fig. 5.5.-1 shows an example of the object tree when it has been built. In the
example tree you can see the SPA-ZC 400 object and its child objects as devices
and data objects. Indentation is used to indicate the parent-child relationship
between the objects.

EET Local Server'REF543R SPA_TCP Test - Communication Engineering Tool for SPA-ZC405% - |EI|5|
File  Edit  Wiew  Tools  wWindow  Help
FH )RR EFE8
Project Explorer Obiject Properties oo
Communication | o & |
Elﬂ REFS43R sPa_TCP Test = [010] Basic
E""Eé ”"':':—':'F'” Default Gateway 192.168.2.1
o IF Add 192.168.2.10
(LI LLND SHTP Sress 1 127.0,0.1
~ LN LPHDL ErvEr e
EI---L_III Lot SMTP Server 2 127.0.0.1
“LM LLMO1 Subnet mask 255.255,255.0
LM LPHD1 TCP-Keepalive 10
B Misc
Zaption SPAZCH0x_SPA
Descripkion SPA TCR QW
B user Level
UserLevel Engineer
Caption
A
A051857
Fig. 5.5.-1 Example view of the SPA-ZC 40x Communication Engineering Tool

24

You have several possible ways to add objects to the object tree in the
communication structure:

¢ You can use the right mouse button (right-click) to select the object to which you
want to add a child object.

e You can copy the object.

e You can select the object using a drag-and-drop operation
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5.5.1.

5.5.2.

Add the objects in the following order:

1. SPAZC40x_SPA Device object (SPA-ZC 40x)
2. Logical Device objects

3. Logical Node objects

4. Data objects

Adding Device object

To build the object tree:

1. Add a SPAZC40x_SPA Device object in the communication structure by
selecting the project name.

In the example, the project Protocol Test is selected.
2. Right-click Protocol Test
3. Select New > Tunneling > SPAZC40x_SPA, see Fig. 5.5.1.-1.

A project can contain several tunneling device objects, for example all substation
feeders.

EET Local Server',ProtocolTest - Communication Engineering Tool for SPA-ZC40%

Blle Edit ‘Wew Tools Window Help

FHyEREE=E0

4

Collapse

| Mew ’_| Mew, .,

Properties IECE1850 »

A051859

Fig. 5.5.1.-1  Adding a Tunneling Device object

Ensure that the new IED name is unique within the planned network by renaming
the IED, for example REF545 FI1.

A Tunneling Device object cannot be configured for an IEC 61850
gateway.

Adding Logical Device objects
For tunneling devices, there is no need to add logical devices inside the parent

object. Logical devices LDO and LD1 are already included to maintain the SCL
compatibility.
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5.6.

5.7.
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Configuring by using imported CID file

If you have to configure several SPA-ZC 400 with the similar settings, it is possible
to import a previously generated CID file and change the communication addresses,
typically by changing the IP address.

Create a new project and add a SPAZC40x_SPA Device. Select the CID import
function by right-clicking the LD1 logical device. In the CID import dialog you can
select the right CID file from the workstation directory and import it to a previously
created logical device.

Configuring communication parameters

SPA-ZC 400 communication parameters are located in the device properties.
SPA-ZC 400 uses static IP addresses, which have to be defined in the planned
network structure.

For uplink network settings, see Sections 5.7.1. Uplink network settings and 5.7.2.
Communication parameters for SPA.
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5.71. Uplink network settings
EETLocal Server'\REF543R SPA_TCP Test - Communication Engineering Tool for SPA-2C40x - |EI|5|
File  Edit Wiew  Tools  Window  Help
s Be EEa0
Project Explarer Obiject Properties q =
Communication | L 4 |
=6 REFS43R SPA_TCP Test B [010] Basic
= Default Gateway 192,168,2.1
IP Address 192,168,2,10
SMTR Zerver 1 127.0.0.1
SNTP Server 2 127.0.0.1
C LW LLNO1 Subnet mask. 255,255,255.0
‘LM LPHOM TCP-Keepalive 10
Bl Misc
Caption SPAZCA0x_SPA
Descripkion SPA TCR GW
B user Level
IJserLevel Engineer
Caption
A
A051857
Fig. 5.7.1.-1 Uplink network settings

e Default Gateway

The IP address Default Gateway defines the gateway address that forwards the IP
traffic between the local subnet and the outside world. The default IP address is
192.168.2.1 and this has to be changed according to the planned network
structure.

IP Address

The IP address identifies SPA-ZC 400 in the local area network (LAN). All
communication via SPA-ZC 400 uses this address. The default value
192.168.2.10 has to be changed to a unique address according to the planned
network structure.

SNTP Servers

SPA-ZC 400 uses SNTP as its own real-time clock. The time is used to
synchronize an IED with SPA. The secondary SNTP server is used if the primary
SNTP server for some reason drops off the network.

27



SPA-ZC 400

Ethernet Adapter
SPA/TCP Bridge

Installation and Commissioning Manual

1MRS756018

5.7.2.

Subnet mask

TCP-Keepalive

Communication parameters for SPA

EETLocal Server\REF543R SPA_TCP Test - Communication Engineering Tool for SPA-2C40%

File  Edit  Wiew  Tools

=10l x|

EH fBR

EEEH

| Project Explorer o= |

Comrnunication |

-8 REFS43R SPa_TCP Test
-8 SPAZCHOx_SPA
}-LD LDO
LN LLMD
¢ Ll LPHD1
=-L0 LD
bl LLMO1
fLN LPHD

Baud Rate
Receive Timeout Fao
Retransmissions ]
SPA-Time>yn Param ]
SPA-Timesynch Enabled
Time Zone Carreckion 120
B Misc
Caption LD1
Descripkion 1ECE1850GW Logical Device
Baud Rate
Baud Rate

Fig. 5.7.2.-1 SPA communication parameters

28

e 2400 bps
e 4800 bps

The possible communication speed settings of the SPA bus are:

The Subnet mask address defines which addresses have access to the default

The status of the TCP/IP connection is monitored by transmitting keep alive-
messages at configured intervals. This is done invisibly to the user. The value is
in minutes and the default is 10 minutes.

A051855
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5.8.

e 9600 bps
e 19200 bps
e 38400 bps

e Receive Timeout

Receive Timeout defines how long SPA-ZC 400 waits for the slave’s respond
before it considers the slave to be non-responding. The unit is milliseconds.

e Retransmissions

Retransmissions defines how many times a message is resent after connection is
considered to be temporarily broken.

e SPA-Timesynch

If enabled, SPA-ZC 400 sends time synchronization messages to the relay. If
SPA-ZC 400 is not connected to a SNTP server, time synchronization to the
slave should be disabled as well.

e Time Zone Correction

Due to the SNTP time synchronization, a time offset must be added to the SPA
time synchronization message depending on the time zone. The value is in
minutes and ranges from -720 to 720. It is comparable to the Coordinated
Universal Time (UTC).

Downloading configuration

After you have built the object tree and done the communication configuration, you
can download the configuration to SPA-ZC 400:

1. Select the SPAZC40x_SPA Device object and right-click to select the CID
Export.

2. If you download configuration to SPA-ZC 400 the first time, change the IP
address from default address (192.168.2.10) to new IP address according to the
planned network structure.

When downloading the device's configuration, the device’s current IP address must
be used as Target IP Address, see Fig. 5.8.-1. When using previously non-
configured SPA-ZC 400, default value (192.168.2.10) should be used.

When the new configuration to SPA-ZC 400 is downloaded, Communication
Engineering Tool (CET) checks if the basic IP addresses are changed. If a change is
detected, CET asks whether new addresses are taken into use. If the changes are not
accepted, SPA-ZC 400 uses the old IP address from the previous configuration. The
IP addresses can be verified with, for example, IP Query Tool. For more information
about IP Query Tool, refer to Section 8.3. IP Query.
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EETLocal Server',REF543R SPA_TCP Test - Communication Engineering Tool for SPA-ZC4( - |EI|5|
File  Edit Wiew  Tools  Window  Help
TR =
| Project Explorer ? %! spazc4ox_spa - CID Export | 11
Communication SPA-ZC 40
=6 REFS43R SPA_TCF Test Target IP Address ' tirite File to SPA-ZC 40x Wirite
[ ‘Write File to Hard Disk
|192.168.2.1IJ o ,
[~ ‘Write File to Hard Disk as ICD
[T Export Datasets DO Level
é'"L_D L1
LN LLMOL
fLM LPHDL
1| | »
s
A060033
Fig. 5.8.-1 Downloading the device's configuration
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If SPA-ZC 400 is connected to a system where the connection to it can be obtained,
the Export function tries to determine the SPA-ZC 400 version and exports the
export file accordingly. If the connection is disabled, prompt the correct version to

be exported, see Fig. 5.8.-2.

CID Export |

] Unable to determine version of SPA-ZC 40x. Do you wank to Export version 2.07(Yes = Export 2.0, Mo = Export
e} 11ap

A060129

Fig. 5.8.-2 Selecting correct SPA-ZC 400 version to be exported
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6.1.

Commissioning

The downloaded Configuration file is taken into use when SPA-ZC 400 is restarted
automatically.

Normally, the device is reset automatically after the configuration is downloaded
with Communication Engineering Tool (CET) for SPA-ZC 40x.

After downloading the configuration you can check the basic TCP/IP functionality
with the ping command in command prompt:

c:\>ping x.X.x.X.

You can see how the configuration process is progressing from the diagnostic LEDs.
When the SPA-ZC 400 configuration is completed, the green LED is on.

If the configuration fails, check the error log files from the SPA-ZC 400 file system.
The status and error logs are located in the /log directory. For more information
about maintenance, refer to Chapter 8. Maintenance and service.

Checking SPA TCP communication

To check the SPA TCP communication, open the SPA/TCP client, for example
Communication Engineering Tool (CET) for the IEC 61850 OPC Server, then send
a >999RF : XX message to SPA-ZC 400. If you receive a reply <999D: SPA-
7ZC40x: XX, the SPA/TCP connection to the device is working.

After that, try to send a >nnnRF : XX message, where nnn is the SPA address of the
slave device connected to the serial port of SPA-ZC 400. In the reply you receive the
slave’s type string.

If you have SPA Time Synchronization enabled in the SPA-ZC 400 configuration,
you see the SPA communication indicator LEDs blinking periodically even if the
SPA/TCP client is not connected.
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71.

Technical data

Interfaces

IED interface

¢ Fixed mechanics and fixed connectors for REF 541/3/5, REM 543/5 and
RET 541/3/5 protection relays

e D-type subminiature connector for simultaneous dual port communication
(optional, see Table 3.1.).

Ethernet interface

e Multimode MT-RJ
e Multimode LC
e RJ-45 for STP CAT5e

LON/SPA interface (Optional)

e Fibre-optic connector options
e ST multimode glass fibre transmitter/receiver pair or

¢ Snap-in multimode plastic fibre transmitter/receiver pair

Optical fibres

e See fibre-optic guides:
e SPA-ZF Optical glass fibres, multimode graded index type
e Plastic-core fibre-optic cables, features and instructions for mounting

For more information, see Section 1.4. Product documentation.

Diagnostic LEDs

SPA-ZC 400 common diagnostic LEDs

e Power

e Diagnostic
e Red
e Green

e Yellow

LAN diagnostic LEDs
e LINK

o TX

e RX
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LON/SPA diagnostic LED
e RX

Dimensions and weight

26
—>
43 20.4
e
A
. O s
MIpp
SPA-ZC 400 [l

ETHERNET ADAPTER

[pLasTic [JGLASS

[JiEc 61850
[ImMopBuUS / TCP

[JspasTcP

LO 00-0C-02-B0-CC-00
y I
[=
SEI;l\{\:CE u
© @
 J
A040130B

Fig. 7.1.-1 Dimensions of the SPA-ZC 400 module
Table 7.1.-1 Dimensions and weight
Type Dimensions [mm] Weight [g]
SPA-ZC 400 195 x 50 x 26 130
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7.2. Test and conditions

Table 7.2.-1 Environmental test and conditions

Recommended service temperature range
(continuous)

-10...+55°C

Transport and storage temperature range

-40...+85°C according to the IEC 60068-2-48

Dry heat test

According to the IEC 60068-2-2

Dry cold test

According to the IEC IEC 60068-2-1

Damp heat test, cyclic

According to the IEC 60068-2-30

Table 7.2.-2

Electromagnetic compatibility tests

EMC immunity test level meets the requirements listed below.

1 MHz burst disturbance test, class Il
e Common mode
¢ Differential mode

According to the IEC 60255-22-1
2.5kV
1.0 kV

Electrostatic discharge test, class lll

e For contact discharge
e For air discharge

According to the IEC 61000-4-2 and IEC 60255-
22-2

6 kV
8 kV

Radio frequency interference tests
e Conducted, common mode

¢ Radiated, amplitude-modulated

¢ Radiated, pulse-modulated

According to the IEC 61000-4-6 and |IEC 60255-
226 10 V (rms), f=150 kHz...80 MHz

According to the IEC 61000-4-3 and IEC 60255-
22-3 10 V/m (rms), f=80...2700 MHz

According to the ENV 50204 and IEC 60255-22-
3 10 V/m, =900 MHz

Fast transient disturbance tests

e All terminals

According to the IEC 60255-22-4 and
IEC 61000-4-4

4 kV

Surge immunity test
e Power supply

According to the IEC 61000-4-5
4 KV line-to-earth, 2 kV line-to-line

Power frequency (50 Hz) magnetic field
IEC 61000-4-8

300 A/m continuous

Electromagnetic emission tests

¢ Conducted, RF-emission (Mains
terminal)

Radiated RF-emission

According to the EN 55011
EN 55011, class A, IEC 60255-25

EN 55011, class A, IEC 60255-25

CE approval

Complies with the EMC directive 2004/108/EC
and the LV directive 2006/95/EC
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Table 7.2.-3 Standard tests

Mechanical tests

Vibration tests (sinusoidal)

Shock and bump test

According to the IEC 60255-21-1, class |
According to the IEC 60255-21-2, class |

Table 7.2.-4 Standard tests

Supply current consumption

Running

Start up

340 mA
430 mA
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8. Maintenance and service
If the SPA-ZC 400 module or a part of it is found to be faulty, the normal service
operation is to replace the entire module.
8.1. LED indicators
Table 8.1.-1 LED indicators
LED Color State Sequence Description
number
Power Green On Power on
Link LAN  |Green On Indication for LAN link OK
RX LAN Green On Indication for incoming LAN traffic
TX LAN Green On Indication for outgoing LAN traffic
DIAG Green Red Off On 1 Bootloader booting
Flashing On 2 Bootloader, missing boot image
On On 3 Starting
Flashing Off 4 OK, missing configuration
On Off 5 OK, configuration in use
Off Flashing 6 Configuration error
RX Green On Indication for incoming LON traffic (LON
and SPA)
Possible sequences are:
1-3->5 Normal situation
152 Missing boot image
1-3-4 Configuration file is missing
1-3->6 Configuration error
8.2. Communication settings

The following IED-specific settings have to be checked when setting up

REF 541/3/5, REM 543/5 or RET 541/3/5:

e Protocol selection for SPA-ZC 400

Table 8.2.-1 explains the possible port configurations of REF 541/3/5, REM 543/5
or RET 541/3/5.

The protocol selection is active only after rebooting the relay. For more
information, see Technical Reference Manuals of REF 541/3/5,
REM 543/5 and RET 541/3/5 .

37



SPA-ZC 400 Ethernet Adapter 1MRS756018
SPA/TCP Bridge

Installation and Commissioning Manual

Table 8.2.-1 Protocol selection for REF 541/3/5, REM 543/5 and RET 541/3/

5
Connectors/Communication parameters
X3.2/Protocol 2 X3.3/Protocol 3 Front connector
SPA (SMS) LON SPA
SPA (SMS) SPA -
IEC 60870-5-1032 LON SPA
IEC 60870-5-103) SPA (SMS) -
IEC 60870-5-103% - SPA
DNP 3.09 LON SPA
DNP 3.09 SPA (SMS) -
DNP 3.0 - SPA
Modbus LON SPA
Modbus SPA (SMS) -
Modbus - SPA
- SPA SPA
IEC 61850 LON SPA
IEC 61850 SPA -

@ Not included in REM 543/5
®) Not included in REM 543/5
) Not included in REM 543/5
9 Not included in REM 543/5
) Not included in REM 543/5
) Not included in REM 543/5

device. By default SPA-ZC 400 is configured to poll SPA events. In

E Only one SPA client can be configured to poll SPA events from the
this case, it is not allowed to poll SPA events from another SPA client.

e SPA command timeout in IED

SPA command timeout should be < 1 second when LON interlocking is not in use.

e SPA baud rate and SPA slave number in IED

Baud rate and slave number have to be according to the SPA-ZC 400 configuration
in X3.2/Communication 2.

8.3. IP Query

By using the IP Query Tool in Communication Engineering Tool (CET) for SPA-ZC
40x, it is possible to see all connected SPA-ZC 40x, devices, their communication
parameters and version information.

Example:

Sending IP query 1
RECEIVED MESSAGE FROM 10.58.125.151:
Mac Address: 00-0C-02-B0-04-89
Subnet Mask: 255.255.255.0
Default Gateway: 10.58.125.150
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SNTP servers:10.58.125.150 127.0.0.1
SW_SPATYPE: SPA-7ZC40x

SW_NUMBER: 1MRS118533

SW_BUILD: 110

SW_REVISION: B

Compiler DATE TIME: Nov 28 2005 12:38:02
To use the IP Query Tool:
1. Select Tools > IP Query Tool to start the tool, see Fig. 8.3.-1.

Query activates devices from the network until it is stopped.

EET Local Server\REF543R IEC61850 Test - C
File  Edit  View | Tools | Window  Hel

= nl clflo h_ Signal Mapping "
|h_ IP Query Toaol

Project Explorer |
Carmmunication | Qptions...

A060127

Fig. 8.3.-1 Starting the IP Query Tool

2. Select the Network adapter to send a query, see Fig. 8.3.-2.
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EET Local Server\Protocol Test - Communication Engineering Tool for SPA-ZC40x I ] |
File  Edit iew  Tools  Window  Help

FH iR EFaD0
[ Project Explarer x| Query Tuul| 1 b o=
Carmmunication I

=8 Protocol Test Guery IPs Network Adapter: [194.241.64.243 7|

-5 SPAZC40x

v Send query as broadcast

Stop Search

Fig.

8.4.

40

A060128

8.3.-2 Selecting Network adapter

3. Click Start to start the query.
4. Click Stop to stop the query.

Connected devices are displayed in the Output pane, Fig. 8.3.-2.

Additional information depends on the SPA-ZC 40x version. If version 1.1.1 is
used, only MAC address is displayed. If version 2.0 is used, MAC address, other
address and revision information is displayed.

Identification
If contacting the Customer Service, it is necessary to send the following information
by request:

e Version information of Communication Engineering Tool (CET) for SPA-ZC
40x

Select Help > About to view the version information.

e SPA-ZC 400 version information



1MRS756018

Ethernet Adapter SPA-ZC 400
SPA/TCP Bridge

Installation and Commissioning Manual

8.5.

The version information can be read from the device's label. If the device is
updated afterwards, use CET's IP query to get the correct version information
from the device memory. For more information about IP query, refer to
Section 8.3. IP Query.

Obtaining error logs

The following session transfers error.log file through fip.

C:\>ftp x.x.x.Xx

User: abb

Password: abb
ftp> cd log

ftp> get error.log
ftp> quit
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9. Ordering information

SPA-ZC400MMG

L Optical transmitter and receiver for SPA/LON bus
P = plastic fibre cable
G = glass fibre cable
- = no fibre option

Ethernet connector type

M= MTRJ
L =1LC
R= RJ-45

Protocol type

M = Modbus/TCP
E = IEC 61850

S = SPA/TCP

t——— Deuvice type

A060158

Fig. 9.-1 Ordering information for SPA-ZC 400

SPA-ZC400CD

e SPA-ZC 400 configuration CD
e Engineering tool, Communication Engineering Tool (CET) for SPA-ZC 40x

get the Communication Engineering Tool. The SPA-ZC 400 package

E Order at least one SPA-ZC 400 configuration CD with your delivery to
does not include the configuration CD by default.
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10. Terminology

Term Description

Communication Engineering | Also known as CET. Software for configuring and monitor-
Tool ing communication gateways or communication front ends.

Intelligent Electronic Device Also known as IED. Devices containing advanced logics
such as meters, protection and control relays and trip units.

Snap-in Connector type for plastic fibre cable
SPA Data communication protocol developed by ABB
ST Connector type for glass fibre cable
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11. Abbreviations

Abbreviation

Description

CD

Change detect; compact disk

CET

Communication Engineering Tool

CID

Configured IED description

EMC

Electromagnetic compatibility

FTP

File transfer protocol

IED

Intelligent electronic device

IP

Internet protocol

LAN

Local area network

LED

Light-emitting diode

LON

Local operating network

PC

Personal computer

SNTP

Simple Network Time Protocol

SPA

Data communication protocol developed by ABB

SQL

Structured query language

STP

Shielded twisted pair

TCP

Transmission Control Protocol

uTtcC

Universal time clock
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